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1. Viabilidad de la implementacion metodolégica

v El software para utilizar es gratuito y de facil descarga de la pagina de la ESA
(Agencia Espacial Europea).

v' Las imagenes para utilizar Sentinel-2 tienen una resolucion. espacial de 10
metros, por lo cual son factibles para realizar un estudio a nivel local.

v" La manipulacion de las imagenes al momento de la descarga es buena ya que
se puede acortar el area para solo tener la escena deseada, y no como Lansat
que el area ya viene dada.

2. Objetivos de aprendizaje

a. Objetivo general:

o Establecer si existe una relacion-entre firmas espectrales obtenidas por medio
de un espectro radidmetro y las obtenidas de una imagen satelital mediante el
software SNAP.

b. Objetivos especificos:

= Generar firmas espectrales de la imagen a través de la obtencion de datos
de reflectancia adquiridos por medio de la informacién del pixel.

= Comparar la curva de las respuestas espectrales de la imagen con la curva
arrojada del espectro radiometro con datos obtenidos en campo.

= Establecer si existe una relacion entre los datos de la imagen y los datos in
situ.
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3. Introduccion

La percepcion remota estudia los objetos sin estar en contacto directo con ellos, para
esto se vale de la radiacidon electromagnética que cruza la atmdésfera e incidesobre los
objetos, cada objeto tiene cierta huella de como se comporta al momento de
interactuar con la radiacién, a esta huella se le denomina respuesta espectral'y se
basa en los valores que el objeto reflecta, llamandose a este fendmeno reflectancias,
es por ello que las respuestas espectrales estan ligadas a las-reflectancias de los
objetos. La reflectancia se da cuando la radiacion electromagnética atraviesa la
atmosfera y la energia incide sobre la superficie terrestre, porlo cuallo objetos reflejan
la radiacion generando curvas de reflectancia espectral de diferentes formas y como
esto se puede identificar diferentes materiales. Estos valores se pueden adquirir
mediante el histograma de la imagen que es donde se representan los valores
digitales de la imagen.

Espectroradiometro: instrumento que explora las diferentes regiones del espectro de
luz, proporcionando representaciones simultaneas de amplitud en funcién de la
longitud de onda del espectro. (Konica Minolta Sensing Americas, 2016)

4. Material y Equipo

e Imagen Sentinel 2 descargada de la siguiente liga:
https://scihub.copernicus.eu/dhus/#/home

o Software SNAP (software gratuito y de facil descarga de la pagina de la ESA)
http://step.esatint/main/download/

SsDésarrollo

Actividad 1

Se descargara la imagen en la pagina de la ESA.
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Desde el explorador se abrira la siguiente pagina:
https://scihub.copernicus.eu/dhus/#/home , pagina oficial de la ESA.

El primer paso es crear un registro, esto para poder acceder a las imagenes de
Sentinel-2 y descargarlas. Para realizarlo, dentro de la pagina en la parte“superior
derecha de la ventana se dara clic en el recuadro SIGN UP (figura 1), al realizar esto
se desplegara una ventana en donde se realizara el registro de un nuevo.usuario, es
importante que al momento de ejecutar esta accion se llenen todos los campos para
no tener problemas al momento de registrarse.

Copernicus Open Access Hub

Figura 1. Registro de usuario.

Una vez realizado este paso se.dara clic en la opcion REGISTER y se desplegara una
ventana emergente la cual indica que se debe ir al correo proporcionado para
confirmar la cuenta, y asi poder acceder a las imagenes de la ESA.

Teniendo la cuenta,se procedera a la descarga de imagenes, para ello se da clic en
LOGIN, esto accediendo desde la ventana de inicio. En el mapa que aparece
dibujaremos el area que se desea descargar (figura2), mediante la herramienta que se
encuentra al derecho (Switch to Area Mode) (figura 3).
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Teniendo seleccionada el area que se desea descargar, en la barra que se encuentra
en la parte superior izquierda (figura 4) se agregan los parametros de la busqueda,
como: la nubosidad de la imagen y el rango'de fechas para buscar la imagen.

Copernicus Open Access Hub
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Figura 4. Barra de busqueda.

Al dar clic sobre el icono de las tres lineas horizontales (figura 5) de lado izquierdo de la
ventana de busqueda se despliegan los siguientes campos.

A Advanced Search
Figura 5. Icono para desplegar los pardmetros de bisqueda

Estos campos se llenaran de la siguiente manera:



\NGENIER[4

%ﬁ%‘ ~ Instituto?

F Nacional o g

' “; > de Pesca\&\v% ﬁ INSTITUTO DE o S LS. s

DB, v Acuacultura & ok = /

w VNIVERSDAD NACJONAL < YDA
S AVENMA DE L7}

MEXICO

Manual de practicas de laboratorio para el procesamiento de imagenes de satélite y
analisis de datos geoespaciales

PROYECTO PAPIME (PE 110218)

A Advanced Search Clear

Se deja por default Ingestion Date y Orde By, ya

» Sort By: Ingestion Date . 1 que asi se indicara que se requieren las imagenes
= ya procesadas, y en Order By sera descendente.

» Order By: Descending v
» Sensing period From: E o = Aqui se indicara el periodo de tiempo en que se
R . - N = . desean las imagenes, se deben llenar ambos

requerimientos

Al continuacion, los campos sobre esa misma ventana nos desplegaran las siguientes
opciones por llenar.

En las especificaciones que se pide llenar, se
& Mission: Sentinel-2 van a-encontrar las opciones Sentinel-1 y
Sentinel-3, seleccionar el campo para ver si
existen imagenes de las zonas deseadas o
simplemente seleccionar Sentinel-2. (En esta
practica se manejara Sentinel-2). Se escoge el
Cloud Cover % (€.9.[0 TO 9.4]) satélite ya sea el S2A o el S2B, y el producto en

este caso sera el S2MSI1C.

Satellite Platform Product Type

S2A * v S2MsI1C| v

Al cumplir con el llenado de los campos, se da clic en el icono de la lupa para que se

desplieguen las imagenes que cumplen con los requisitos agregados en los campos.
(figura 6)

¥ close

Figura 6. Icono para desplegar los pardmetros de bisqueda
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Para visualizar una imagen y observar si cumple con los parametros que se necesitan,
basta con dar clic en el icono view product details que se despliega al pasar el mouse
por cada imagen. (figura 7)

S2A_MSIL1C_20180412T165851_N0206_R069_T14QMF_20180412

73 Oounload URL: hips #50ihud. copemicus euihusiodatal 1/Products('4é
nA e Misson Sentngl-2 Instrument MS! Sensing Date’ 2016-04-12T16:582
? @\

S2A_MSIL1C_201804027165851_N0206_RO69_T14QN View Product Detads
C A memeeTo l

Figura 7. Visualizaciéon de la imagen

Al realizar este paso se desplegara una ventana emergente en donde se observa la
imagen y la informacion, para de esta forma saber sila imagen conviene o se busca
otra que cumpla con los requisitos que se deseen. (figura 8)

S2A_MSIL1C_20180402T165851_N0206_R069_T14QMF_20180402T234023

https://scihub.copernicus.eu/dhus/odata/v1/Products('94060994-06f1-421c-b305-5cfe5d0b9a4r)/$value

A Footprint
alle o 4 ] "y _lv""" & - . . “’ ™ |

L Here
ihuaics, ises v
_

Inspector
A Summary B e

Figura 8. Visualizacion de la imagen

En caso de que la imagen cumpla con los requerimientos se procede a descargarla
dando clic en el boton de descarga. ©

Actividad 2

La imagen se descarga en un archivo comprimido, al descomprimir se puede
manipular la imagen, una vez que se haya realizado esto, se procede a abrirla en el
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software de SNAP, mediante los siguientes pasos: Una vez abierto el software de
SNAP nos dirigiremos a la barra de menu (figura 9) y se seleccionara la opcion File
>Open Product, donde se debe buscar la direccion del archivo de la imagen
descomprimida y seleccionar el archivo “MTD_MSIL1C”; este es el metadato de la
imagen, en donde se cargaran las bandas que la componen.

8 [1] S2B_MSIL1C_20180417T16584
File| Edit View Analysis Layer Vec
=3 Open Product...

Reopen Product »
4  Product Library L
Close Product

Close All Products

Save Product

Save Product As...

o
9
]
a
3
@

v vovw

Figura 9. Abrir la imagen

Del lado izquierdo de la ventana aparece el nombre de la imagen (figura 10)

File Edit View Analysis Layer Vector Raster Optical Radar Tools Win¢

A L B XA Nk LILK

Product Explorer 2 | Pixel Info
R =" (1] S28_MSIL 1C_20180417T 165849_N0206_R069_T14QMG_20180417T22)

. »

[ Mavigatio... % [ Colour Mani... |uncertainty ... [Worldview | &
r

Figura 10. Visualizacion de la imagen cargada

Para visualizar el contenido del archivo, basta dar clic en el icono de mas que esta al
costado izquierdo (figura 11).

Product Explorer £ | Pixel Info

[1] 52B_MSIL 1C_20180417T165849_N0206_R069_T14QMG_20180417T22

Figura 11. Icono con signo “mds”
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Y se desplegaran los datos que contiene el archivo (figura 12).

Product Explorer | Pixel Info =
EM=YY[1] 528_MSIL 1C_20180417T165849_N0206_R069_T14QMG_20180417]f8

- Metadata

(£33 D Vector Data

(=3 a Bands

2] [:] sun

2] D view

E B1(443rm)
[ 82 (450 nm)

----- [ 83 (560 nm)
[ B4 (665nm)
@ 85 (705nm)
[ 86 (740 nm)
E 87 (783nm)
[E 88 (342nm)

B RrRa /RAS nm)
< [0 | »

Figura 12. Datos que contiene el archivo.

La composicion de colores, se hace mediante los pasos siguientes.

Se da clic derecho sobre el nombre de la imagen, en el menu que se despliega
seleccionar Open RGB Imagen Windows (figura 13). Si queremos color verdadero
(figura 14) o falso color (figura 15) se dara clic en la opcion de ProFile para seleccionar
la composicion que se desea, como siguiente paso se da OK. (figura 16)

Product Explorer X | Pixel Info — || (2] Sentinel 2SI Natural Coly E clect R o -
- — Select RGB-Image Channels
[ER=1 1] 525_MSIL 1C_20180417T 165849 _N0206_R069_T14QLF :
Band Maths..
Add Elevation Band Profie:
AddlandCoverBand |
Group Nod Sentinel 2 MSI Natural Colors = :m:
Open RGB Image Windo
Open HSV Image Window Red: |B4 Ve
Close Product > Green: |B3 MIS
E/ TRt Be: [B2 =
Save Product
Save Product As... [] Store RGB channels as virtual bands in current product
Ctrl+X
| Navigatio... | Colou... x |uncertain... | World View [Quicki  Copy Ctrl+C
Ctrisv
Qe e [ ][ concsl [ e
o @ @ pett beee [o| J
[ Neme: 54 Propertes

Figura 16. Seleccion de color verdadero.

Figura 13. Seleccionar la composicion.

Figura 15. Falso color

Figura 14. Color verdadero
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Actividad 3
Sobre la imagen se cargara el shapefile de los puntos que se obtuvieron en trabajo de

campo para de esta forma tomar las reflectancias de los puntos.

Para poder cargar el shapefile nos dirigiremos a la barra de menu, en donde
seleccionaremos la opcidén vector>Import, después se seleccionara la opcion ESR/
Shapefile (figura 17). Al momento de hacer eso se abrira la ventana en donde se‘debe
seleccionar el archivo, se dara clic en open y automaticamente se cargara el shape
sobre la imagen (figura 18).

Vector Raster Optical Radar Tools Window Help

Dot

l\:'k New Vector Data Container n % el ;:c £

Geometry from WKT b ] [ [1] Sentinel 2 MSI Natural Colors RG

Import > SeaDAS 6.x Track
Export > Vector from CSV
MERMAID Extraction File

ESRI Shapefile
& In-Situ Data Access

Figura 17. Cargar shapefile

Figura 18. Visualizacion del Shapefile

Sobre la imagen nos apareceran los puntos, en este ejemplo de practica manejaremos
4 puntos.

Actividad 4
Una vez cargados los puntos sobre la imagen, en la parte de la barra menu, se

seleccionara la opcion.de View y en el menu que se desplegara se dara clic en la
opcion Tool Windows y posteriormente en Pin Manager (figura 19), se desplegara un
recuadro en la parte de abajo (figura 20).

View Analysis Layer Vector Raster Optical Radar Tools Window Help
Tool Windows > eveloper >
Toolbars > ical > x X
o adar >
— In-Situ Data Access
X

(]
Show Only Editor Ctrl+Shift+ Enter
Full Screen AltShifts Enter

2R3
SHp=ES

(& Quicklooks

®

B Navigation
%@ Pixelinfo . . .
& Produtbplorer Figura 20. Cuadro de herramientas de Pin Manager
o View Projects
® World Map
@ WorldWind Analysis View
Word View
&1 Properties
& Log Output Ctrl+d

Figura 19. Agregar cuadro de herramientas de Pin Manager
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Como segundo paso en la barra de menu seleccionaremos el icono ~ (pin  placing
tool) (figura 21) la flecha cambiara a una cruz, de esta forma se seleccionan los puntos
que previamente se cargaron mediante el shape.

Cuando se coloque la cruz sobre el punto se da clic de esta forma una.marca se
pondra al centro del pixel (figura 22) y a la par, se mostrara en el recuadro de-abajo la
informacion de la marca (figura 23).

Window Help
GCP @ : ol 222 0Oe [% Q«r? Q% cP |:| O AN N T
@ "‘.‘j- * oot " -+ \+ - 5 + + I:'aeg [aasana]
Figura 21. Icono pin placing tool

X Y Lon Lat Color Label
8057.500| 6234.500| -99.185312]  19.332915| NN Pin 1
7977.500] 6333.500| -99.192918[  19.323962 Pin 2
7954.500] 6408.500| -99.195099]  19.317181 Pin 3
8183.500| 6404.500] -99.173300]  19.317565 Pin 4

Figura 23. Informacién de los puntos mostrados en el recuadro
inferior

Figura 22. Ubicacion de marcas

Para cambiar el color de las marcas y el nombre, basta con tan soélo dar doble clic
sobre el recuadro de color (figura 24) y el de Label (figura 25), para poder editarlas.

X Y Lon Lat Color Label
8057.500| 6234.500|  -99.185312 19.332916| Islas
7977.500| 6333.500]  -99.192918 19.323%62| Campos
7954.500| 6408.500 -99,195099 19.317181 Jardin Botanico
8183.500| 6404.500 -99.173300 19.317565 Cantera

Figura 24. Edicion de color

Campos

>(()

Cantera

Jardin Botanico

Figura 25. Edicion de nombre
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Actividad 5
En la siguiente actividad lo que se pretende es la de obtener las reflectancias por

medio de graficas para compararlas con las que graficas generadas por el
espectroradiometro. En el recuadro de Pin Manager se da clic en el icono Y (Filter
pixel data to be displayed in table), en la ventana que aparecera se observa que se
pregunta sobre las bandas en las que se mostrara la reflectancia (figura 26),
seleccionaremos las bandas, 2, 3 y 4, ya que estas son las bandas conlas que se
compuso la imagen, solo basta con seleccionar el cuadro y dar en OK.

{3 Available Bands And Tie Point Grids X
D B1 Reflectance in band B1 (443.0nm) A B
= Reflectance in band B2 (490.0 nm) a
B2 Reflect in band B3 (560.0 nm) =
BQ Reflect: band B4 (665.0 nm)

Oles Refi band B5 (705.0 nm)

D BE Refie band B6 (740.0 nm)

Oer Ref band 87 (783.0 nm)

[Ces Refi band B8 (842.0 nm)

D BSA Reflect: band BEA (865.0 nm)

Cles Reflectance in band B3 (345.0 nm)

Osto Reflectance in band 810 (1375.0 nm)

Oen Reflectance in band B11 (1610.0 nm)

Oez Reflectance in band B12 (2150.0 nm) ,
[Jselectall []Selectnone

Cancel

Figura 26. Seleccion de reflectancias a ocupar

En el recuadro apareceran las columnas de las reflectancias en esos puntos (figura 27)

X Y Lon Lat Color Label B2 B3 B4

8057.500| 6234.500 -99.185312)  19.332916 | NN Islas 0.1186 0.1149 0.1353
7977.500 6333.500]  -99.192918 19.323962t:’ Campos 0.1078 0.1098 0.0811
7954.500] 6408.500) -99.195099|  19.317181 | Jardin Botanico 0.0967 0.09 0.0669
8183.500| 6404.500 -99.173300)  19.317565| | Cantera 0.1037 0.0982 0.0727

Figura 27. Columnas de reflectancia

Teniendo estos valores el siguiente paso es agregar una nueva herramienta, esta
herramienta se agrega para poder visualizar graficos, para ella en la barra de menu
seleccionarla.opcion View >Toolbars y enseguida la opcién de Tool Windows. (figura
28)

View Analysis Layer Vector Raster Optical Radar Tools Window Help
>EANE B i
> ||[v ] File

Tool Windows

Toolbars

Statusbar

T —
NSy | S

Synchronise Image Cursors

Synchronise Image Views

Full Screen

Alt+Shift+Enter

Figura 28. Afiadir la herramienta Tool Windows

Clipboard

Projects

Radar Tool Windows
Undo/Redo

Analysis

Overlay

Processing

Tools

Tool Windows
Window Arrangement

Performance
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En la barra de herramientas apareceran nuevos iconos (figura 29) que son los que
agregamos al seleccionar esta herramienta.

Q

Figura 29. Iconos agregados a raiz de activar la herramienta de Tool Windows

Al tener estas nuevas herramientas seleccionamos el icono (Spectrum View) y se
desplegara una ventana en donde al momento de pasar la flecha por los puntos
sefalados dibujara la reflectancia. (figura 30)

e X
Spectrum View X
Spectrum View Y
1.0 [\% v
0.9 )
0.8 -
0.7 V.
0.6
0.5 No product selected \ 7t
0.4 @
0.3
0.2
0.1
0.0
0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
Wavelength (nm) @

Figura 30. Ventana en donde se mostrardn las graficas de las reflectancias

Actividad 6
Como siguiente actividad se van a comparar las graficas obtenidas mediante el

software de SNAP, y las graficas obtenidas mediante el espectroradiometro

—_— . e W o
I 1
Spectrum View X o
S04 ,‘_qls.}ii;] / gr042618.009
Spectrum View Y
0.8 [Q\W o al
o7 & g / 0r042618.010
06 o i
T 04 L x®
204
03 r042618.011
- **-A?-, Foe i
02 * - e
1] Fe A b S 107
0.0 H . i - -
500 750 1,000 1,350 1,500 1,750 2,000 2,350 . L L / 0r042618.012
—1 ———1—
Wavelength (nm) 350 450 S50 650 750 850 950 1050
e i

Firma espectral espectroradiometro
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Actividad 7
Para tener una comparacidn mas acerca de las reflectancias se realizara una

composicion en HSV (saturacion, composicion y brillo) la finalidad de llevar acabo
esto, es comparar si las reflectancias siguen siendo las mismas o por el proceso
llevado dentro de la imagen, los valores cambian. Para realizar esto, en el menu
principal, en la pestafia de Windows y en la lista que se despliega seleccionar la
opcion de Open HSV Image Window (figura 31), al hacer clic en automatico se
desplegara una nueva pestafia en donde se mostrara la imagen ya con la composicion
llevada a cabo.(figura 32)

Window Help

Open Image Window
B Open RGB Image Window
i%1 Open HSV Image Window

v

Tile Horizontally
Tile Vertically

Tile Evenly

Tile Single ‘
New Workspace... Ctrle W = V%
Jardin Botanico Cantera
Figura 31. Opcién para llevar a cabo la composicion en HSV. Figura 32. Imagen con composicion en HSV.

Una vez realizado este paso, se hara el paso de la actividad numero 4 y 5 en caso de
que los puntos que previamente cargados no aparezcan.

Anexo
En la mayoria de las ocasiones no es posible contar con un espectroradiémetro, pero

esto no es impedimento para llevar a cabo esta practica, ya que la NASA da a conocer
el comportamiento de firmas espectrales para ello basta ir a la siguiente liga:
https://speclib.jpl.nasa.gov/ en donde se encuentran las graficas de las respuestas
espectrales.

Una vez estando dentro del portal, en la parte izquierda, en donde se encontrara un
menu en el que se seleccionara la opcion de Search Library esto con el fin de acceder
al compendio de firmas espectrales (figura 33).
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JPLHOME EARTH SOLARSYSTEM STARS & ES SCIENCE
Jet Propulsion Laboratory BRING THE UNIVERSE TO YOU: JPL Emai
California Institute of Technology

@ECOSTRESS

Spectral Library

Download Links

[ Home || Documents Search Librar,

You are here: Home

NASA/JPL

(Mg aRo ECOSTRESS Spectral Library - Version 1.0
/I\ Home Welcome to Version 1.0 of the ECOSTRESS speciral library (formally ASTER spectral library). The ECOSTRESS spectral library

s a
compilation of over 2800 spectra of natural and man made materials. Version 1.0 of the ECOSTRESS spectral library was released on
(O Documents

February 2nd 2018. These libraries were developed as part of the ASTER and ECOSTRESS projects
C (2 search Library D

Adenostoma fasciculatum 1

(O Download =

(D Links

Figura 33. Search Library

Al realizar estos pasos se desplegara una nueva ventana en donde se deben

seleccionar ciertos criterios para. ver la respuesta espectral del pasto, en Select
Spectral Type (figura 34) seleccionaremos: Vegetation (544).

Spectral Library

The ECOSTRESS spectral library (formerly ASTER spectral library) includes a comprehensive search tool which ai.ows you to search the library database for your material

The search returns a list of materials that match your search criteria, you can click on any of the items in the returned list to see a scaled plot of the spectrum and the ancillary
information for the specioim yolLG so dowr

the spectral data

Select Spectral Type:| Vegetation (544)

| Order All "Vegetation' Spectral

| View Cart ‘ Checkout

En la parte de abajo dice: Vegetation Search Results, seleccionar en Class la opcidn
de grass:

Vegetation Search Results
Filter by:

Class| grass ¥

Figura 34. Select Spectral Type
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Se desplegara una tabla en donde se visualiza los resultados de grass, se
seleccionara la opcion de Grass, para ver la grafica damos clic en view plot (figura 35)

Name Plots Class
Avena fatua view plot grass
Avena fatua view plot grass
Bromus diandrus view plot grass
Bromus diandrus view plot grass
Grass view plot grass

Figura 35. Tabla con opciones de pasto

Grass
o0 ! ! ! ' ! ‘
i : : : : : :
50 -l EETTEPR EET P e e EETE PR . .
f |‘n| : : : :
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c .
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o= [l
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o [1:
8 | ‘ :
20kt L ............... ............... ............... ............... ............... .............. i
" ‘EII I'|
o A : : 5 : 5
_’I ......... ! . .'l‘A ........... o ASIITLTIITLIIE oo eseneeneanass Preseseeeseees N
| I\ "; \
AN : .
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Grafica respuesta espectral del pasto, NASA.
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